
Chapter 1: Getting Acquainted
with Excel

In This Chapter
� Finding out what Excel can do for you

� Discovering the ways to start Excel

� Getting familiar with the Excel window

� Getting around the worksheet and workbook

� Issuing commands in Excel

Before you go off trying to find out how to do things in Excel, you really
need to know what the program is capable of doing. Therefore, I start

this chapter with an ever-so-brief overview of the kinds of things that you
can do with Excel 2003.

Also, without a sure grasp of the rock-bottom basics of Excel (such as load-
ing the program, entering information in cells, choosing commands — that
kind of stuff), moving on and trying to figure out some of the spiffier fea-
tures in Excel can become not only frustrating, but also just downright
counterproductive. To ensure that this doesn’t happen as you pick and
choose among the many topics in the rest of this book, I have dedicated the
first chapter of this first book to a review of Excel fundamentals.

By taking a second to glance over the material in this chapter, you can get
yourself in a good position to really go through the exciting stuff found in
the rest of the desk reference. By making sure that you’re right on the
money with your Excel basics, you’ll have no trouble taking on new features
of this spine-tingling program (and, hopefully, you can even have a lot of fun
with them).

What’s Up with Excel?
After Word, Microsoft’s word-processing powerhouse, Excel is the most pop-
ular program (also known as an application program or application) in the
Microsoft Office suite. Excel holds this distinction, no doubt, because it
entirely fulfills most people’s number-crunching needs, which in modern
business, comes right after their word processing needs. 
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Excel accomplishes this number crunching by combining sophisticated
charting (also known as graphing) and data-management capabilities with a
sophisticated and powerful spreadsheet program. You’re probably aware
that, as a spreadsheet program, Excel merges the grid layout of an accoun-
tant’s green sheet with the calculating power of his or her handheld calcula-
tor. This means that not only can you use the program’s spreadsheet
capabilities to lay out spreadsheet applications (such as financial state-
ments, expense reports, and the like) in the row/column grid arrangement,
but you can also use the program’s built-in calculating ability to compute all
the required subtotals, totals, and grand totals.

This combination of abilities makes Excel a natural for any type of applica-
tion that uses some sort of tabular layout or relies on extensive calculations
between the data that the application requires. For example, you may use
Excel to create many fill-in-the-blank paper forms that require no calcula-
tions at all. (Many people find that designing forms in Excel’s grid layout is
much easier than using Word’s Table feature.) You may also use the program
to create business-type forms, such as expense reports and sales and inven-
tory sheets that involve extensive calculations.

The worksheet grid
The key to successfully using Excel as a spreadsheet program is in under-
standing its grid-like nature. Figure 1-1 shows you this grid in all its glory
(without most of the program and sheet controls that normally appear when
you start the program). By the way, in Excel, you always refer to this type of
grid as a worksheet.

Note the following items about the grid shown in Figure 1-1:

✦ The columns of a worksheet are identified by letters (A, B, C, and so on)
that appear across the Column header. When Excel runs out of letters
(at column 26), it starts duplicating letters (so that column Z is followed
by AA, AB, AC, and so on until it reaches column IV).

✦ Numbers (1, 2, 3, and the like) identify the rows of a worksheet, up to
row 65,536. The numbers appear down the Row header.

✦ The intersecting gridlines of each column and row form a rectangular
box known as a cell.

✦ A totally blank worksheet is a pretty boring affair!

The most important thing to keep in mind about the worksheet is that each
cell can hold its own data, depending upon the function and layout of the
spreadsheet that you’re building.
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Getting a cell’s address
Cells, by the way, are identified by their position in the grid; their so-called
cell address. This address is normally noted with the cell’s column letter fol-
lowed by its row number. So the first cell (located at the intersection of the
first column and row) in every Excel worksheet has the address A1, the cell
in the first row of the second column has the address B1, the cell in the
second row of the first column has the address A2, and so forth.

I say that a cell address is “normally” noted as a combination of its column
letter and row number only because you can switch to a different style of
cell address notation, known affectionately as the R1C1 reference style. It has
this wonderful appellation because, in this system, R1C1 is the first cell of
every worksheet instead of A1. You turn on the R1C1 system by choosing
Tools➪Options and then, on the General tab in the Options dialog box, click-
ing the R1C1 Reference Style check box.

Note the following two big differences between the normal A1 style cell
addresses and the R1C1 style addresses:

Column header

Row header

Figure 1-1:
The basic
Excel
worksheet
grid.
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✦ R1C1 style addresses don’t ever use the column letter. In fact, numbers
replace the letters in the column header, as shown in Figure 1-2.

✦ R1C1 style addresses always note the row position, and then the column
position of each cell. Normal A1 style cell addresses do the opposite
by first noting the position of the column position (by letter), and then
the row.

The big advantage of the regular A1 style cell addresses is that they’re shorter.
Therefore, most people find them easier to deal with (especially in formulas),
because their addresses don’t have to include the R and C abbreviations
(letters always designate columns and numbers always designate rows).

The big disadvantage of the A1 style cell address is that the cell addresses
must duplicate letters in order to designate any column past 26 (and each
worksheet contains a total of 256 columns). When referring to cell addresses
hanging out in the wilds of a worksheet, the R1C1 cell address system sud-
denly doesn’t seem so bad. For example, if you’re using the R1C1 style
address system and the data you want is in cell R1C52 of the worksheet, you
have a good idea of the cell’s general location relative to the first cell. If, on
the other hand, you’re using the normal A1 style reference system, and the
data you want is in cell AZ1, you probably don’t have a clue where that cell
is located in relation to the first cell, A1, except that it’s somewhere pretty
far over in the same row.

Figure 1-2:
Basic Excel
worksheet
grid using
the R1C1
style
reference.
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Identifying the active cell
Regardless of which cell address system you have turned on, Excel indicates
which cell you’re working with at any given time (known as the active cell or
current cell) in three ways:

✦ Listing its cell address at the beginning of the row immediately above
the row with the worksheet’s Column header (this area is known as the
Name box)

✦ Highlighting in gold the cell’s column and row in the Column and Row
header, respectively

✦ Displaying a heavy black border around the cell in the worksheet grid
itself (known as the cell pointer)

Figure 1-3 illustrates these three ways of identifying the active cell. In this
figure, you can bet your bottom dollar that cell C7 is the active cell in this
worksheet because C7 appears in the Name box and the cell pointer is located
at the intersection of column C and row 7, which, in turn, are both highlighted
in a golden color on the Column and Row borders of the worksheet.

The three basic spreadsheet tasks
As I see it, you almost always end up doing the following three basic tasks
when creating a new spreadsheet table or list:

✦ Entering the headings that define the layout of the spreadsheet table or
list

✦ Entering the data in the table or list

✦ Formatting the data that you entered in the table or list

Turning off R1C1 references in a worksheet
Most worksheets that you’ll run across use the
normal A1 style cell address system (because
this is the program’s default setting for cell
addressing and most people don’t even know
the R1C1 system exists). Suppose that someone
in the know switches to the R1C1 system and
saves the Excel file with R1C1 turned on. When
you open the file, all cell references in the for-
mulas of its worksheets use that system and the
Column header contains numbers just like the

Row header. You can always switch back to the
normal cell reference style by choosing
Tools➪Options and then clicking the R1C1
Reference Style check box on the General tab
(to remove its check mark). This check box is
located at the top of the View tab in the Options
dialog box. After you choose OK, all cell refer-
ences in the formulas change back to the A1
style reference system, and the Column header
once again uses letters.
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Note that most spreadsheet tables have both a row of column headings and
a column of row headings that identify the different types of data that the
tables contain. This stands in contrast to lists (also called data lists or data-
bases in Excel) that use only a row of column headings at the top to identify
their data.

The data that you enter in the cells of your table or list (see Book I, Chapter 2,
for details) can consist of text, numbers, or even formulas that perform
essential calculations. These calculations may use values or even some-
times text entered in other cells of the table or list.

After you’ve entered all the data, the formatting of the table or list data is
mostly done. In formatting the data, you actually change the formatting of
the cells containing the data. In other words, instead of actually making the
text that you’ve entered in a particular cell bold and italic (as you might do

Name box with cell address

Cell’s column highlighted

Cell’s row highlighted

Cell pointer

Figure 1-3:
Identifying
the active
or current
cell in the
worksheet.
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in a Word document), you assign these attributes to the cell that holds this
text. This way, the bold and italic attributes remain associated with the cell
even after you delete the text or replace it with a number or a formula that
returns a calculated value. Because formatting is so important in building a
spreadsheet in Excel, I devote an entire chapter to it (see Book II, Chapter 2).

Beyond the spreadsheet
Although working with spreadsheets is definitely Excel’s strong suit (thus
the worksheet as the underlying document), it is by no means the program’s
only claim to fame. As an adjunct to its basic spreadsheet abilities, Excel
adds sophisticated charting and data analysis capabilities, along with a set
of features that offer an uncomplicated approach to database management.

All these extra features make some sort of use of the basic worksheet grid
and, in the case of charting and data analysis, actually work with the data
entered in spreadsheet applications (for details on charting, see Book V and
for details on data analysis, Book VII). In the case of database management,
Excel adds the ability to perform routine tasks, such as sorting and filtering,
on data that you’ve actually entered in a worksheet in the form of a data list
or have imported from other external sources, such as a dedicated database
management program, such as Microsoft Access or the company’s corpo-
rate database (see Book VI for details on performing these kinds of tasks).

Getting Excel Started
Excel is simply no fun at all if you can’t get the blasted thing to run! So I
want to begin this portion of the Excel “basics” material with an overview of
the many ways you can get Excel up and running (and then I discuss ways
that you can catch it!). Starting Excel 2003 under Windows XP gives you no
lack of options.

Starting from the Windows taskbar
The steps for starting Excel from the Windows XP taskbar are as follows:

1. Click the Start button at the beginning of the taskbar.

The Start menu appears.

2. Position the mouse pointer over the All Programs item at the bottom
of the Start menu.

A submenu appears, showing the oodles and oodles of programs
installed on your computer.

3. Click the Microsoft Excel item on the Programs menu to fire up Excel.
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One nice thing about starting Excel from the Windows XP taskbar is that
Windows automatically adds Microsoft Excel to the Start menu, as shown in
Figure 1-4. So the next time you need to start the program, you can do it
even more quickly by simply clicking the Start button and then clicking the
Microsoft Excel item on the Start menu. Just keep in mind that Excel’s
appearance on the Windows XP Start menu is only a temporary advance-
ment. As you continue to launch other programs besides Excel (such as
Word, for example), Windows eventually knocks Excel off the Start menu
and replaces it with a more recently launched program.

Starting Excel with a desktop or toolbar shortcut
If you use Excel extensively in your work, it probably won’t take too long
before the procedure for starting Excel using the Windows Start button wears
a little thin. In such cases, you need to add a desktop or Quick Launch tool-
bar shortcut for starting the Program, or you need to start using the built-in
Excel button on the Office Shortcut bar (described in the very next section).

To add a desktop shortcut for Excel, you need to find the program file that
actually runs the Excel application (a nifty little executable file called
excel.exe) and then use the file to create a desktop shortcut. Here’s how
you do that:

1. Click the Start button on the Windows XP taskbar.

The Windows Start menu appears, containing a Search item.

2. Click the Search item on the Start menu and then click All Files and
Folders in the Search Results dialog box.

3. Type excel.exe in the All or Part of File Name text box.

4. Click the Search button.

Windows begins searching your computer’s hard disk looking for the
excel.exe file that starts the program.

5. Click the Stop button when the Excel file, listed as an Application
type, appears in the Search Results dialog box.

Now, all you have to do is send a shortcut to this program file to your
computer’s desktop.

6. Right-click the Excel file, and then position the mouse pointer on
Send To on the shortcut menu and click the Desktop (Create Shortcut)
on the cascading menu.

Windows responds by creating a Shortcut to Excel on your desktop. You
see the shortcut as soon as you close the Search Results dialog box.

7. Click the Close button in the upper-right corner of the Search Results
dialog box to get rid of it.
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As soon as you close the Search Results dialog box, you should see your
Shortcut to Excel icon (just like the one shown in the left margin). To start
Excel with this desktop shortcut, you simply double-click the icon or right-
click it and then click the Open item on its shortcut menu.

If Microsoft Office Excel shows up on the Frequently Use Programs list when
you click the Start button on the Windows XP Start button, you can create a
desktop shortcut by clicking the Start button, right-clicking Microsoft Office
Excel 2003 and then highlighting Send To on the shortcut menu and clicking
Desktop (Create Shortcut) on the submenu.

The only drawbacks to desktop shortcuts are that you need to double-click
them or right-click them and then click the Open item on their shortcut
menus (which seems like a lot work to go through for a shortcut!). Shortcuts
also tend to move around and get lost as you add more and more desktop
items (if your desktop is anywhere near as messy as mine, you may never
find the blasted thing). 

To avoid these kinds of hassles, you can copy the Excel desktop shortcut to
your Quick Launch toolbar that appears to the immediate right of the Start
button on your Windows taskbar. This way, you can always find your Excel
shortcut, and you only have to single-click it (as you do with any other tool-
bar button in Windows) to get Windows to launch the program.

Figure 1-4:
The Start
menu in
Windows
XP after
adding a
Microsoft
Excel item.
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To add a copy of the Excel desktop shortcut to the Quick Launch toolbar at
the beginning of your Windows taskbar, follow these steps:

1. Drag the Shortcut to Excel icon from the desktop to the place on the
Quick Launch toolbar where you want it to appear.

If you want the icon to appear at the very beginning of the bar right
after the Start button, drag the icon until it’s positioned on the Quick
Launch bar, and a thick, black vertical bar that represents where the
icon will be inserted appears in front of the first button on the bar.

2. Release the mouse button as soon as the vertical bar appears at the
place where you want it.

As soon as you release the mouse button, Windows adds an Excel button
(indicated by the Excel program icon shown in the left margin). After you’ve
added this button to the Quick Launch bar, you can start Excel by clicking
this button. If you ever need to remove it, simply drag the button off the
Quick Launch bar. When you release the mouse button, the Excel button
immediately disappears.

Figure 1-5 shows my Windows XP desktop after adding an Excel 2003 short-
cut to both the Windows desktop and the Quick Launch toolbar.

Starting Excel by opening one of its document files
The last technique for starting Excel simply involves opening a document
file created with the program. Windows, wisely following in the footsteps of
the Apple Macintosh, associates each application program’s executable file
with all files that that program generates. This means that as soon as you
try to open an Excel document file (referred to as a workbook or workbook
file), Windows checks to see if Excel is already running. If it is, Windows
simply opens the selected workbook file in the application. If, however,
Excel is not yet running, Windows automatically starts Excel before opening
the selected workbook file in it.

To open a particular workbook file and, if necessary, launch the Excel pro-
gram at the same time, simply locate and then double-click the workbook’s
file icon (similar to the one shown in the left margin). Alternatively, you can
right-click this icon and then click Open on its shortcut menu.

Don’t forget that you can create desktop shortcuts to Excel workbook files
that you routinely edit and print just as you do for the programs that rou-
tinely run. To create a shortcut icon for an Excel file, locate and open its
folder, right-click the workbook file icon, and then highlight Send To on its
shortcut menu before you click Desktop (Create Shortcut) on its cascading
menu. Then, to open the file and launch Excel all in one stroke, you only
have to double-click the Excel workbook desktop shortcut.
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Getting to Know the Excel Window
When you start Excel, the program loads in a full-size program window enti-
tled Microsoft Excel. As Figure 1-6 shows, the Excel program window is com-
posed of several distinct areas, each of which contains its own elements.
The Excel window is divided into the following areas:

✦ Title bar: Located in the first row at the top of the screen, it contains a
Control menu button (that displays a pop-up menu of options for
moving and resizing the screen), the title of the application (Microsoft
Excel), a Minimize button, and a Restore Down button.

✦ Menu bar: Located in the next row, it contains the pull-down menus that
enable you to select various Excel commands for use in doing your
work in the program. This bar also contains the Type a Question for
Help box and the active document window’s Minimize Window, Restore
Window, and Close Window buttons.

Desktop shortcut

Quick Launch toolbar shortcut

Figure 1-5:
The
Windows
XP desktop
after adding
an Excel
desktop and
Quick
Launch
toolbar
shortcut.
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✦ Standard and Formatting toolbars: Located side by side on the next
row, each of these toolbars contains a series of buttons that, when
clicked, perform commonly used Excel commands.

✦ Formula bar: This bar is comprised of three areas. The Name box is
located at the far left and displays the current cell reference. The Cancel
and Enter boxes are located in the middle and are for entering or editing
data in the current cell, along with the Insert Function button (with the
fx icon). A third area, located to the right, displays the contents that
you’re entering or have entered into the current cell.

✦ Excel work area: This area, located between the Formula and status
bars, contains all the document windows with the Excel workbooks that
you have open. Normally, Excel displays only the document window
with the active worksheet in the active workbook in the middle of the
work area.

✦ Task Pane: Located on the right side of the Excel work area, this pane
contains one of many different panes: 

• Getting Started — for opening new or existing workbook files

• Help — for getting online help

• Clipboard — for managing data that you store in the Windows
clipboard

• Basic File Search — for finding workbooks that you need to edit

• Clip Art — for finding and using Windows clip art images in your
worksheets 

✦ Status bar: Located at the bottom right of the Excel window, this is
divided into two parts. The first part displays messages about the cur-
rent state of the program or the Excel command that you are about to
select. The second part contains five mode indicators that tell you when
certain keys — such as the Num Lock, Extend (F8), or Caps Lock keys or
modes — are engaged.

The title bar
The title bar for the Excel window displays the name of the application
(Microsoft Excel) between the program Control menu button (with the XL
icon) on the left and two sizing buttons and the Close button on the far
right. When you click the Control menu button, the program displays the
Control menu. You can use the options on this menu to resize the Excel
window, or to close the Excel window (and subsequently quit Excel).

When you first start Excel, the two sizing buttons located on the right side
of the title bar consist of a Minimize and Restore Down button (shown
respectively in the left margin). You click the Minimize button to reduce the
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Excel window to a button on the Windows taskbar (this is the equivalent of
choosing the Minimize option on the Excel Control menu). You click the
Restore Down button to reduce the Excel window down to a midsize window
in the middle of the Windows XP desktop (this is the equivalent of selecting
the Restore option on the program Control menu). Note that you can then
move and resize the midsize windows, reconfiguring your desktop as needed.

When the Excel window is reduced to a button on the Windows XP taskbar,
you can restore it to full size by clicking the button. When the Excel window
is reduced to a midsize window, the Restore Down button on the title bar
changes to a Maximize button (shown in the left margin). You click the
Maximize button to restore Excel window to full size (this is the equivalent
of selecting the Maximize option on the program Control menu).

Title bar

Standard and Formatting toolbars

Menu bar

Formula bar

Excel work area

Status bar

Task Pane

Task Pane

Figure 1-6:
The Excel
Window as
it appears
when you
start the
program.
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The menu bar
The menu bar contains nine pull-down menus (from File to Help) on the left
side. You can use these menus to select the Excel commands necessary for
creating your worksheets. On the right side of the menu bar, you find the
Type a Question for Help text box, which enables you to access the Excel
online Help system by typing in a question (see Book I, Chapter 2, for more
details). Located to the immediate right of the Type a Question for Help box,
you find the Minimize Window, Restore Window, and Close Window buttons.

As with all the other Windows programs you use, you can choose the com-
mands on the pull-down menus with the mouse or the keyboard. For more
information on how to do this, see the “Making Menu Requests” section
later in this chapter. As with the other applications in the Office 2003 suite,
you can also choose menu commands by voice if your computer is
equipped with a microphone. For detailed information on how to do this see
the “Issuing Voice Commands” section later in this chapter.

The Minimize Window, Restore Window, and Close Window buttons located
on the right side of the menu bar use the same icons as the Minimize,
Restore Down, and Close buttons located above, on the title bar: 

✦ Click the Minimize Window button to reduce the active, full-size work-
book window to a button at the bottom of the Excel work area.

✦ Click the Restore Window button to reduce the active full-size workbook
window to a midsize window with a title bar equipped with its own set
of Minimize, Maximize, and Close buttons.

✦ Click the Close Window button to close the active workbook — Excel
automatically prompts to save the file if you made changes to it since
the last time you saved the workbook.

To restore a workbook that you’ve reduced to a mere button at the bottom
of the Excel work area to its previous mid size, click its Restore Up button
(using the same icon as the Restore Down button). To restore it to full size,
click the Maximize button (you can also choose the Restore or Maximize
items on the Control menu; these automatically pop up whenever you click
the minimized workbook window button).

One of the easiest ways to restore a minimized workbook button is to use
the Alt+Tab keystroke to cycle through all the windows (Excel and other-
wise) that you currently have open; these are shown in an unnamed dialog
box that appears in the middle of your screen. Continue pressing Alt+Tab
until Windows selects the icon for the workbook that you want to restore
(indicated by the filename that appears beneath the Excel file icon enclosed
in a blue square in this unnamed dialog box).
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Note that as soon as you click the Restore Window button, Excel removes
the Minimize Window, Restore Window, and Close Window buttons from the
menu bar and the Ask a Question text box takes their place on the far right
side of the bar. It does this because the newly restored, midsize workbook
window has its own set of Minimize, Maximize, and Close buttons on its own
title bar. If you click the Maximize button on the active workbook window’s
title bar, the Minimize Window, Restore Window, and Close Window buttons
magically reappear on the right side of the menu bar, moving the Ask a
Question text box back towards the middle.

The Standard and Formatting toolbars
The next bar in the Excel window contains two of the most basic toolbars
in the program: the Standard toolbar on the left and the Formatting toolbar
on the right. Because Excel 2003 automatically places both of these toolbars
on the same row of the Excel window, you can’t actually see all of the but-
tons on either toolbar. 

To display buttons that are currently hidden on either of the two toolbars,
you need to click the bar’s Toolbar Options button (shown in the left
margin) to display a pop-up menu that shows the rest of the buttons on
that bar. Note that the two greater than symbols (>>) above the downward-
pointing arrow form a continuation icon and indicate that not all the buttons
are displayed.

To see the name of any button on any toolbar in Excel, position the mouse
on its icon until the name appears in a small box to the side. To display the
Standard and Formatting toolbars on separate rows, one above the other, so
that you always have access to all buttons on both bars, click the Toolbar
Options button on either toolbar and then click the Show Buttons on Two
Rows item on the pop-up menu. If you need more screen real estate, you
can return the two bars to their original row-sharing arrangement by click-
ing the Toolbar Options button on either toolbar (it’s the last button on
each bar whose icon now lacks a continuation icon and simply sports a lone
downward-pointing arrow).

To use a Standard or Formatting toolbar button, simply click its icon (no
need for you to double-click). If a button has a pop-up button (indicated by
a smaller, square button with a downward-pointing arrow icon located to its
immediate right), click this button to choose among a list of further options
(for example, you can click the Font’s pop-up button to select a new font
size directly from its pop-up menu).

For information on how to move and size the Excel toolbars, see the “Taking
the Toolbars to Task” section later in this chapter.
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The Formula bar
The Formula bar is one of the most important rows in Excel. The first area,
called the Name box, displays the address of the active or current cell (this
address automatically changes as you move the cell pointer through a work-
sheet or select a group of cells for editing or formatting). Note that the
Name box has its own pop-up button. You use this button in worksheets
where you’ve given groups of cells (called cell ranges) common names, such
as sales tax, dividend, and grand total (a technique covered in Book III,
Chapter 1); you can select the cell range by choosing its range name from
the associated pop-up menu.

Located immediately to the right of the Name box, you find an area reserved
for the Cancel, Enter, and Insert Function buttons. Note that Excel keeps the
Cancel and Enter buttons hidden until you either start entering data in the
active cell or start editing it, as shown in Figure 1-7. The Insert Function
button (with the fx icon), however, is displayed on the Formula bar at all
times.

Cancel Insert FunctionEnter

Figure 1-7:
The Cancel
and Enter
buttons
appear on
the Formula
bar during
data entry
or editing.
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You click the Cancel button to abort the data entry or edits that you’re
making in the active cell. You click the Enter button to complete data entry
or editing. (Note that this is by no means the only way to do this. See Book
II, Chapter 1, for details.) You click the Insert Function button to insert (or
edit) one of Excel’s many built-in functions in a formula that you’re building.
Functions are ready-made formulas that perform specialized computations,
some of which are quite complex (see Book III for complete information on
their usage).

The Excel work area
The work area takes up most of the Excel window. As the name implies, this
is the place that holds the workbook document windows where you build
and edit your spreadsheets. Normally, only a single, full-sized worksheet
appears in this space, although you can make Excel do windows, meaning
that you can split the work area up into smaller window panes in which
parts of other worksheets (in the same or different workbooks) can be dis-
played. See Book I, Chapter 4, for details on how to do this.

Even when a worksheet is displayed in a full-sized workbook window in the
work area, you can see only a small fraction of the cells that it contains
(each worksheet in every workbook that you open consists of 256 columns
and 65,536 rows, giving you a grand total of 16,777,216 cells with which to
work). To enable you to bring currently hidden columns and rows into view,
the workbook window contains both a vertical and horizontal scroll bar. You
use the horizontal bar to scroll back and forth through the columns and the
vertical bar to scroll up and down the rows. See the “Getting Around the
Worksheet” section later in this chapter for details.

Because each new workbook that you open automatically starts out with
three blank worksheets (each with their own 16,777,216 cells arranged on a
grid with 256 columns and 65,536 rows), you find sheet scroll button and
sheet tabs to the immediate left of the horizontal scroll bar at the bottom of
each workbook window. You use these controls to activate different work-
sheets in the workbook so that you can work with their cells (see the
“Navigating the Workbook” section later in this chapter).

The Task Pane
The Task Pane is a great addition to the major productivity applications,
such as Excel, Word, and PowerPoint in the Office 11 suite. Whenever the
Task Pane is displayed, it appears on the right side of the Excel work area,
obscuring part of the open worksheet. 
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When you first start Excel, the program automatically opens the Getting
Started Task Pane to facilitate opening a new workbook or one that you
have recently edited. As soon you select an existing workbook or open a
new workbook using the links provided, Excel automatically closes the
Getting Started Task Pane for you. To then reopen the Task Pane, you just
press Ctrl+F1 or choose View➪Task Pane from the Excel pull-down menus.

Getting Started is just one of many different Task Panes that you can use.
For example, in addition to Getting Started, Excel offers a Help, Search
Results, Clip Art, Research, Clipboard, and New Workbook Task Pane. To
switch to another task, click the Other Task Panes drop-down button, as
shown in Figure 1-8, and then click the name of the pane that you want dis-
played. After you’ve used this pop-up menu to display a Task Pane other
than the default Getting Started, you can then click the Forward and Back
buttons at the top of the Task Pane window (with the left-arrow and right-
arrow icons, respectively) to jump back and forth between the one you
selected and the original pane.

To return to the Getting Started Pane from any other Task Pane, click the
Home button. To quickly close the Task Pane so that the entire worksheet
area is displayed on-screen, press Ctrl+F1.

CloseOther Task Panes

Figure 1-8:
Selecting a
new Task
Pane to use.
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The status bar
Last but not least is the status bar, the final element of the Excel window
(the Windows taskbar located immediately beneath the status bar does not,
strictly speaking, belong to the Excel program, although it is continuously
displayed as you use the application program). The status bar keeps you
informed of the current state of the program as you use it. The left side of
the status bar displays messages on the current state of the program.
Usually, this area contains the Ready indicator, signifying that Excel is now
fully prepared to accept new data in the current cell or some type of Excel
command. The other important indicator that you often see in this area of
the status bar is the Edit indicator, signifying that the program is ready to
accept the changes that you want to make to the contents of the current cell.

The right side of the status bar contains five mode indicators. These indica-
tors tell you when certain lock keys, such as the Caps Lock, Num Lock, or
Scroll Lock, are toggled on. (These keys are called toggle keys because you
turn them on by pressing the key once, and they stay on until you turn them
off by pressing the same key again.) In addition to these keys, this area tells
you when three other modes are active in Excel. Table 1-1 explains all the
mode indicators that appear in this part of the status bar.

Table 1-1 The Various Modes of the Status Bar
Mode Key to Turn On/Off Function

EXT F8 Extends the current cell range as you select other
cells with the arrow keys

ADD Shift+F8 Adds to the current cell range all cells you select
with the arrow keys 

CAPS Caps Lock Types all letters in uppercase

NUM Num Lock Engages and disengages the numeric keypad on
your keyboard

SCRL Scroll Lock Freezes the cell pointer in its current position as you
scroll the worksheet

OVR Insert Types over existing text, replacing it with the charac-
ters you type

END End Combined with one of the four arrow keys (→, ←, ↓,
or ↑), moves the cell pointer to the first cell with data
that’s adjacent to a blank cell in the direction of the
arrow 

FIX (none) Indicates that Excel is ready to automatically add a
set number of decimal places to any value that you
enter in a cell (turned on and off by choosing
Tools➪Options and then selecting/
deselecting the Fixed Decimal Places check box on
the Edit tab of the Options dialog box)
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Getting Around the Worksheet
Regardless of your computer screen size and screen resolution, very little of
the total worksheet is displayed at any one time. You may create a few
spreadsheets that use only the portion of the sheet that’s visible when you
open it in Excel. Chances are, however, that most of your spreadsheets will
be larger, either in terms of columns and rows of the worksheet, than the
area that can be displayed at one time on your screen.

Because your average Excel spreadsheet is going to be too large to all fit on
the screen at once, you need to move the cell pointer and scroll new parts
into view almost any time you sit down to work with this software. This
being the case, I suggest that you take a second to review some of the more
important shortcuts for moving the cell pointer and scrolling the worksheet. 

Excel 2003 gives you several different basic ways of moving the cell pointer
to different parts of the worksheet: 

✦ Keyboard via the arrow keys and special cursor keys (Home, End, Page
Up, and Page Down) alone and in combination with the Ctrl key

✦ Mouse by moving new parts of the worksheet into view with the work-
book window’s scroll bars and then clicking the cell

✦ Use the Go To dialog box (which can be opened by pressing Ctrl+G or F5
or choosing Edit➪Go To on the menu bar)

✦ Voice command using Excel’s Speech Recognition feature (see the
“Issuing Voice Commands” section later in this chapter)

Keyboarding
Excel offers you plenty of ways to move the cell pointer with the keyboard.
The most obvious way is to press the four arrow keys to move the cell
pointer one cell at a time in the arrow’s direction. Table 1-2 lays out all your
options for moving the cell pointer from the keyboard.

Table 1-2 Keystrokes for Moving the Cell Pointer
Keystroke Movement

→ or Tab Next cell to the right

← or Shift+Tab Next cell to the left

↑ Next cell up

↓ Next cell down

Home Cell in column A of whatever row contains the cell pointer

Ctrl+Home First cell (A1) of the worksheet
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Keystroke Movement

Ctrl+End or End, Home Last cell in the active area of the worksheet

Page Up Cell that’s one screenful up in the current column

Page Down Cell that’s one screenful down in the current column

Ctrl+→ or End, → First occupied cell to the right adjacent to a blank cell 

Ctrl+← or End, ← First occupied cell to the left adjacent to a blank cell 

Ctrl+↑ or End, ↑ First occupied cell up adjacent to a blank cell 

Ctrl+↓ or End, ↓ First occupied cell down adjacent to a blank cell

The keyboard shortcuts shown in Table 1-2 also automatically scroll the
worksheet if scrolling is necessary to move to and select the cell. For exam-
ple, suppose that the cell pointer is currently in the last column visible in
the worksheet window. In this case, if you press Tab or the → key, Excel
scrolls the worksheet one column to the right when it selects the next cell
over. Likewise, if you press the Home key when the cell pointer is located in
a column many columns to the right, Excel scrolls the entire screenful of
data when it selects the cell in column A of the current row.

Among the many keystrokes for moving the cell pointer, the ones that com-
bine the Ctrl or End key with an arrow key are among the most helpful for
navigating large blocks of cells, such as tables, that span more than one
screenful, or for moving between tables in a complex worksheet.

When you use Ctrl and an arrow key to move around a table or between
tables in a worksheet, you hold down Ctrl as you press one of the four arrow
keys. When you use End and an arrow key, you press and release End before
you press the arrow key. Pressing and releasing the End key causes Excel to
display the END indicator on the status bar, indicating that the program is
waiting for you to press one of the four arrow keys. Because you can keep
the Ctrl key depressed as you press different arrow keys, the Ctrl+arrow key
method provides a faster, less disjointed means of navigating blocks of cells
than the End, arrow key method.

Mousing around
To use the mouse to move the cell pointer around a worksheet, first use the
workbook window’s scroll bars to move the part of the worksheet with the
cell you want to view in the document window and then click that cell to
make it active. 

To scroll the worksheet grid one row at a time, click the scroll arrows on the
vertical scroll bar (click the up arrow to scroll up by a row and the down
arrow to scroll down). To scroll the worksheet one column at a time, click
the scroll arrows on the horizontal scroll bar (the left arrow to scroll left by
a column and the right arrow to scroll right).
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To scroll the worksheet one screen at a time, click the area on the scroll bar
between the scroll box and the scroll arrows. To scroll the sheet up or down
one screenful at a time, click the vertical scroll bar (above the scroll box to
scroll up and below the scroll box to scroll down). To scroll the sheet left or
right by one screenful, click the horizontal scroll bar (left of the scroll box to
scroll left and right of the scroll box to scroll right).

For faster scrolling through a large worksheet, you can drag the scroll box.
The size of the scroll box reflects the relative size of the active area of the
worksheet. The active area is defined by the cell located at the intersection
of the furthest column to the right and the row the furthest down in the
worksheet that contains data entries (any cell in this column or row can
contain the data entry — the cell at this intersection can, in fact, be empty). 

Because the size of the worksheet’s active area determines the relative size
of the scroll box in both the vertical and horizontal scroll bar, it also indi-
rectly determines how many columns and rows of the worksheet scroll as
you drag the scroll box to a new position in the scroll bar. The bigger the
active area, the faster you can scroll through it by dragging the scroll boxes
in the vertical and horizontal scroll bars.

Go To
The Go To feature provides the most direct way to move to a distant cell or
cell range in the worksheet. You can display the Go To dialog box, shown in
Figure 1-9, by using any of the following techniques:

✦ Press Ctrl+G

✦ Press F5

✦ Choose Edit➪Go To on the Excel menu bar

Seeing is not the same as selecting!
When using the mouse to move the cell pointer,
don’t forget it’s simply not enough to scroll the
cell that you want to work with into view. You
still have click the cell in order to activate it. If
you forget this essential step and start trying to
enter data in the blank cell you’re now staring

at, Excel will suddenly scroll you back to the cell
in the earlier part of the worksheet that does
contain the cell pointer, which is where the
characters you’ve been busily typing away
appear.
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To move the cell pointer to a particular cell in the worksheet, type its cell
reference in the Reference text box, and then click OK or press Enter. Note
that when you enter the cell reference, you can type the column letter(s) in
upper- or lowercase.

Excel remembers the cell addresses of the cells that you visit and lists them
in the Go To list box. The address of the very last cell that you selected is
also automatically entered into the Reference text box. You can therefore
quickly return to your previous place in a worksheet by pressing F5 and
Enter. To return to another previously visited address in the list box of the
Go To dialog box, simply double-click its address, or you can click the
address and then click OK.

Navigating the Workbook
Each new workbook that you open in Excel contains three blank work-
sheets, which you can use as necessary in building your spreadsheet.
Having more than one worksheet at your disposal enables you to separate
different parts of a complex spreadsheet on individual worksheets in the

Figure 1-9:
Using the
Go To dialog
box to move
the cell
pointer.
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workbook (as you do individual sections of a complex report on different
pages of a word-processed document). If you find it necessary, you can also
easily insert additional worksheets into the workbook to accommodate new
sections of data (see Book II, Chapter 4, for details).

To make it easy to move among the different sheets in a workbook, click the
tabs located at the bottom of the workbook document window. Clicking a
sheet’s tab makes it active (meaning that its data is displayed in the work area
as though the sheet were now sitting on top of the others in the workbook).
You also find a series of tab scrolling buttons to the immediate left of the
sheet tabs, which enable you to scroll through the sheet tabs in workbooks
that contain more than the standard three worksheets. Figure 1-10, for exam-
ple, shows a workbook that contains so many worksheets that not all their
sheet tabs are visible at any one time at the bottom of the document window.

First tab

Previous tab

Next tab

Last tab

Figure 1-10:
Using the
tab scrolling
buttons to
scroll
through a
workbook
with more
than three
worksheets.
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The following are a couple of ways to move from one worksheet to another
within the current workbook:

✦ Click the tab for the sheet that you want at the bottom of the work-
book’s document window. If the sheet tab for the worksheet you want to
move to isn’t displayed, click the Next tab scroll button until the tab
that you’re looking for appears, and then click the sheet tab to activate
the worksheet and display its data in the workbook document window.
To redisplay a previous sheet tab, click the Previous tab instead.

✦ From the keyboard, hold down the Ctrl key as you press Page Down and
Page Up to move from sheet to sheet. Pressing Ctrl+Page Down moves
you to the same cell in the next sheet in the workbook. Pressing
Ctrl+Page Up moves back up through the sheets in the workbook.

To scroll the last set of sheet tabs in a workbook into view, click the Last tab
scroll button. To scroll the first set of sheet tabs into view, click the First tab
button.

Making Menu Requests
Although the pull-down menus in Excel menu bar were specifically designed
for using the mouse to select items, you can just as well use the keyboard if
you prefer. 

✦ To open a pull-down menu with the mouse, click the menu name. To
display all the items on the menu, click the Continuation button at the
bottom (indicated by two downward-pointing greater than symbols)
or wait a few seconds. To select an item on the menu, click it. To open
a cascading submenu attached to an item (indicated by a right-pointing
triangle), highlight the item and then click the desired item on the
submenu.

✦ To open a pull-down menu with the keyboard, press the Alt key plus the
hot key (that is the letter that is underlined in the command). For exam-
ple, pressing Alt+E opens the Edit menu. Alternatively, you can press
F10 to activate the menu bar, press → or ← to select the desired menu,
and then press ↓ to open the menu. To display all the items on the
menu, press ↓ until you highlight the Expand button (the one at the
bottom with downward pointing arrows) or wait a few seconds. To
select a menu item, press ↓ to highlight it and then press Enter. To open
a submenu attached to an item, press ↓ to highlight that item and then
press → to open the submenu. To select an item from the cascading
submenu, press ↓ to highlight it and then press Enter. 

04 53758X Bk01Ch01.qxd  9/5/03  2:14 PM  Page 35



Making Menu Requests36

If you’re one of the few remaining Lotus 1-2-3 users on the planet who is
finally switching to Excel, you’ll be happy to know that you can also press
the / (slash) key instead of F10 to activate the pull-down menus.

After you’ve opened a pull-down menu, you can select any of its menu items
by clicking the item with the mouse, typing its hot key, or pressing the ↓ key
until the item is highlighted and then pressing the Enter key. 

Some Excel commands have shortcut keys assigned to them. The shortcut
keys assigned to a command are shown after the item’s name on the appro-
priate pull-down menu. If you prefer, you can use the shortcut keys to select
the command instead of using the pull-down menus. For example, to save an
Excel document, you can press the shortcut keys Shift+F12 or Ctrl+S instead
of choosing the Save option on the File menu.

Can we talk?
When using the Excel pull-down menus, you’ll find that the selection of
many menu items results in the display of a dialog box offering you oodles
of further options from which to choose instead of actually executing a com-
mand. You can always tell that selecting a particular menu item results in a
dialog box of further options because the item name on the pull-down menu
is followed by an ellipsis (...), or three periods in a row.

The controls found in the Excel dialog boxes comprise all the standard bells
and whistles (actually buttons and boxes are more like it) that you find in
any other Windows application (especially those in the Office 2003 suite).
Complex dialog boxes, such as the Format Cells and the Options dialog box,
offer so many options that they don’t all fit in a single box. Therefore, these
dialog boxes contain separate tabs that, after they are clicked, display a new
slate of related options.

You can activate and/or select options in Excel’s dialog boxes by clicking
them, but don’t forget that you can also do this by pressing the Tab key. If
the options on a particular tab of a dialog box have hot keys (underlined let-
ters), you can also select them by pressing the Alt key plus the letter key
(note that you can’t always just type the hot key letter because many dialog
box options accept or respond to text entry). 

When a menu item is off-limits
If a menu item appears in light gray on the menu (also referred to as being
dimmed), this means that the item isn’t currently available for selection
because the conditions under which it operates are not yet in effect. For
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example, the Paste item on the Edit menu remains dimmed as long as the
Windows Clipboard is empty. As soon as you cut or copy some data to the
Clipboard (with the Cut or Copy items on the Edit menu), the Paste menu
item appears in normal bold type when you open the Edit menu, which lets
you know that Paste is now ready to use.

When not all menu items are displayed
As Excel has become more and more sophisticated, the list of menu items
on some of its pull-down menus has grown until they hang down almost to
the bottom of the screen. In an attempt to tighten up the menus without
dropping needed commands, Excel 2003 doesn’t immediately display all the
items on a given menu. You can always tell that you’re looking at an abbrevi-
ated menu because a Continuation button (with two downward-pointing
greater than symbols, one on top of the other) appears immediately
beneath the very last menu item.

To display all the items on an abbreviated menu, you can either wait a few
seconds or click this Continuation button. Note that, after you’ve expanded
one menu to its full size, Excel automatically displays all items on any subse-
quent menus that you open (that is, until the next time you activate the
menu bar). If you prefer having all the menu items displayed whenever you
open any pull-down menu (which is a very good idea when you’re first
becoming familiar with its commands), you can switch from abbreviated to
a full-menu setting.

When deciding whether you want to work with these abbreviated menus,
remember that Excel doesn’t always display the same items on the abbrevi-
ated menu each time you open it. Because Excel watches which of the items
you choose most often on any given menu, it always tries to make sure that
these items are displayed on the abbreviated menu. This means that menu
items you seldom use will most certainly be hidden until you expand the
menu to its full form. Take it from me — this can make it very difficult to find
an occasionally used item when you’re not 100 percent sure which menu it’s
on. It’s so much easier to track down a wayward menu item when you know
that you’re looking at the full menus.

To switch to full menus so that Excel shows you all the menu items each and
every time you open any of its menus, follow these few steps:

1. Right-click the menu bar (or somewhere on the Standard/Formatting
toolbar).

A long shortcut menu appears.
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2. Choose the Customize item at the very bottom of the shortcut menu
by clicking it or pressing C.

The Customize dialog box appears with the Options tab selected.

3. Click the Always Show Full Menus check box on the Options tab.

This action automatically deselects and deactivates the Show Full
Menus After a Short Delay check box (which now becomes dimmed).

4. Click the Close button to close the Customize dialog box.

Shortcut menus
In addition to the full-blown pull-down menus you find on the Excel menu
bar, the program offers a variety of specialized menus, called shortcut menus.
Shortcut menus are attached to individual screen objects that you routinely
encounter in the Excel window, such as the toolbars, worksheet cells,
column and row headers, and sheet tabs.

To open an object’s shortcut menu, simply right-click the object. An object’s
shortcut menu contains only menu items that are relevant to that object.
For example, if you right-click one of the toolbars, the shortcut menu that
appears contains only menu items for viewing and hiding and customizing
the various Excel toolbars. Likewise, if you right-click one of the worksheet
tabs, the shortcut menu that appears contains only menu items for doing
stuff with sheet tabs, such as inserting and deleting tabs, renaming tabs,
moving and copying tabs, and so on.

Figure 1-11 shows the shortcut menu that’s attached to every cell in the
worksheet. You can view the menu by right-clicking a cell or pressing
Shift+F10. In the figure, you can see that items on shortcut menus often have
hot keys (such as the m in the Insert Comment item). You can press the hot
key letter (such as M) on your keyboard to select that item. Just be aware
that you still need to press Enter to actually invoke the command attached
to that item.

Shortcut menus are invaluable when working with hyperlinks and graphic
objects that are embedded in a worksheet, such as charts, comments, Clip
Art, and other types of pictures. This is because shortcut menus give you
fast, direct access to just the menu options you need in order to edit that
particular kind of object. See Book VIII, Chapter 2, for details on using links
and Book V, Chapters 1 and 2, for information on adding charts and graphics
to the worksheet.

04 53758X Bk01Ch01.qxd  9/5/03  2:14 PM  Page 38



Book I
Chapter 1

Getting Acquainted
w

ith Excel
Issuing Voice Commands 39

Issuing Voice Commands
Excel 2003 supports a Speech Recognition feature, which enables you to
issue voice commands that allow you to choose menu items, dialog box
options, or even toolbar buttons by simply saying their names. According to
Microsoft, to use speech recognition in Excel, your computer must be at
least a Pentium II running at a minimum speed of 300 MHz with a minimum
of 128MB of RAM.

You also need a top-quality microphone, preferably one that’s attached to
a headset (like the kind office receptionists typically use). The giveaway
microphones that come with today’s PCs are just not sensitive enough for
speech recognition. These mics tend to pick up stray sounds that make it
impossible to correctly process your voice commands.

For information on how to use the Dictation portion of the Speech Recognition
feature to do data entry in your worksheet, see Book II, Chapter 1. While
you’re there, you can look up information on how to use the Text To Speech
feature (a separate, but related new speech feature unique to Excel 2003) to
validate the data entries that you make in a worksheet.

Figure 1-11:
Right-
clicking a
cell to open
its shortcut
menu.
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Installing and training the Speech 
Recognition feature
If you or the person who installed Office 11 on your computer performed a
Standard installation, then Speech Recognition won’t be installed until you
first try to use the feature in Excel 2003 (or one of the other Office programs
such as Word or PowerPoint). To install Speech Recognition, have your
Office 11 CD-ROM handy and follow these steps:

1. Choose Tools➪Speech➪Speech Recognition on the Excel menu bar.

An Alert dialog box displays, indicating that this feature isn’t currently
installed and asking if you want to install it now.

2. Click the Yes button in the Alert dialog box.

Excel displays an Installing Components for Microsoft Excel dialog box,
which is then replaced by a Microsoft Office 2003 dialog box, telling you
to insert the Microsoft Office 2003 disk.

3. Insert the CD with your Microsoft Office 2003 programs in the
CD-ROM drive and then click OK.

Excel installs the Speech Recognition components while displaying its
progress in an Installing Components for Excel dialog box. 

Upon completion of this installation, a Welcome to Speech Recognition
dialog box appears, indicating that you must adjust your microphone
and train Office for speech recognition. 

4. To do this adjustment and training, you need to have your micro-
phone and speakers properly hooked up. You also need about 15 min-
utes of uninterrupted time and a fairly quiet environment. 

5. If you already have Speech Recognition installed, you can do this
training by clicking the Tools button on the Language bar (Tools➪
Speech➪Speech Recognition) and then clicking the Training option
on its pop-up menu.

6. Click the Next button and then follow the on-screen instructions dis-
played in the Microphone and Voice Training Wizards. 

After you complete this initial microphone adjustment and speech
recognition training, a new window appears with a brief multimedia
presentation explaining how to make the best use of the Office 2003
Speech Recognition features. After that finishes playing, you’re ready to
begin using speech recognition for both entering data and issuing Excel
voice commands.
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If you’re serious about using speech recognition to do data entry or to
choose Excel commands, you should complete more than just the initial
voice training because the more training you do, the higher the recognition
accuracy rate. You can do more training sessions by clicking the More
Training button that appears in the final Voice Training dialog box at the end
of your initial training session. You can also do this at any later time by
choosing Tools➪Speech➪Speech Recognition to display the Language bar,
and then clicking the Tools button on this bar and Training on its pop-up
menu. In the Training dialog box, you can select the passage that you want
to read. By eventually reading all the training sessions, you can really
increase your accuracy rate, especially when dictating the data that you
want entered in your spreadsheet.

Saying commands
After you’ve completed basic voice training, you can start using the Speech
Recognition feature to issue your menu, toolbar, and dialog box selections
verbally. To issue voice commands, you only need to display the Language
bar and then put Speech Recognition into Voice Command mode. When you
display the Language bar, it remains a floating toolbar on the Excel window
at all times (see the next section, “Taking the Toolbars to Task,” for details)
unless you minimize the bar. When you do this, Excel adds the buttons on
the Language bar to the Windows XP taskbar (immediately to the left of the
Notifications area that contains the clock and icons for other items that are
running). By minimizing the Language bar on the Windows taskbar, you
ensure that its buttons are always out of the way of the Excel screen so that
you don’t ever have to interrupt your speaking to move the floating
Language bar out of the way.

To open the Language bar, minimize it on the Windows XP taskbar, and then
get it into Voice Command mode, follow these steps:

1. Choose Tools➪Speech➪Speech Recognition to display the Language
bar.

Excel opens the floating Language bar in the middle of the Excel
window.

2. Click the Minimize button (the one with the minus sign icon) at the
right end of the floating Language bar.

Excel adds all the buttons currently displayed on the Language toolbar
to the right side of the Windows taskbar.
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3. Click the Voice Command button on the Language bar that now
appears on the Windows XP taskbar, shown in Figure 1-12.

Note that you can also say, “voice command,” to select this button. You
can tell that the Language bar is in Voice Command mode because the
words Voice Command replace Starting Speech or Listening in the
Language bar’s Mode Indicator (the button with the balloon almost
midway in the bar).

After Speech Recognition is selected, you’re ready to command your little
heart out.

Choosing menu items, dialog box options, and toolbar buttons
To choose pull-down menus or to select buttons on an open toolbar (such
as the Standard or Formatting toolbar), say the menu and item name or the
toolbar’s button name. For example, to choose File➪Save on the pull-down
menus to save changes to the current workbook, you say “file,” and then
when Excel opens the File menu, you say “save” to choose the Save menu
item. Alternately, you can just say, “save,” if you want Excel to simply select
the Save button on the Standard toolbar.

If you say a menu command that opens a dialog box, you can select its tabs
or options by saying their names. For example, if you say, “format,” and then
say, “cells,” the Format Cells dialog box opens. You can select the Font tab in
this dialog box by saying, “font,” and then you can select the Strikethrough
check box option by saying, “strikethrough.” To then close the Format Cells
dialog box and apply the strikethrough attribute to the entry in the cur-
rently selected cell(s), say, “Okay.” To close a dialog box without putting
into effect any of the options that you changed, say, “cancel,” instead (you
can also say, “escape,” to close a dialog box without making changes).

Keep in mind that you can use Voice Command to select the dialog box
option that you want to change. Say, “tab,” to have Excel advance through
each of the options displayed on the current tab of a dialog box, selecting
each option as it goes. When the dialog box option that you want to change
is selected (indicated by highlighting in the case of text boxes and combo
boxes, and dotted outlining in the case of radio buttons and check boxes),
you can then say the new value or suspend Voice Command and enter the
new value manually.

If you need to enter a new value in one of the text boxes in a dialog box (or
select a value in a pop-up list when you don’t already know its name), you
must first turn off Voice Command temporarily and then enter or select the
new value with the keyboard or mouse. To turn off Voice Command, simply
click the Microphone button on the Language bar, thus causing the bar to
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hide the Dictation and Voice Recognition buttons. To resume giving voice
commands after you have entered or selected the new value, click the
Microphone button on the Language bar a second time. 

Don’t forget to turn off Voice Command before you start clicking objects in
the Excel window with the mouse or typing something from the keyboard,
because if you do — mark my words — you stand a good chance of having
Voice Command decide that your mouse clicks or typing sounds like some
Excel menu command or toolbar button. Having Excel choose a harmless
command that you’re not expecting can be bad enough, but having the pro-
gram choose one that alters your worksheet can be devastating (usually
when I forget to first turn off Voice Command, it responds by having Excel
open up a new, blank worksheet, which totally throws me off because the
worksheet with all my data is suddenly no longer on-screen!).

Microphone Dictation

Voice Command

Mode 
Indicator

Speech Tools

Handwriting

On-Screen Keyboard

Help

Options Restore

Figure 1-12:
Click the
Voice
Command
button
on the
Language
bar to speak
Excel
commands.
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Note that the effects of many of the Excel commands that you choose
(whether you do this by voice, keyboard or mouse ) are reversible by imme-
diately using the program’s Undo command. (Some commands, such as
saving changes in a document, are not reversible, however.) If Speech
Recognition ever messes up and chooses the wrong menu command, tool-
bar button, or dialog box option, immediately say, “undo.” Because Excel
supports multiple levels of undo, you may have to repeat the word several
times to get your worksheet back to the desired state.

Telling the cell pointer where to go
You can use Voice Command to move the cell pointer to new cells in the
worksheet by saying the following words and phrases:

✦ “Right” or “right arrow” to move the cell pointer one column to the right 

✦ “Left” or “left arrow” to move the cell pointer one column to the left 

✦ “Up” or “up arrow” to move the cell pointer one row up 

✦ “Down” or “down arrow” to move the cell pointer one row down 

✦ “Home” to move the cell pointer to the beginning of the line 

✦ “End,” and then pause before you say the name of an arrow key (“up,”
“down,” “left,” or “right”) to move the cell pointer to the edge of the
next data region or worksheet boundary in that direction

You have a much better chance of having Excel’s Speech Recognition feature
understand your meaning if you say a phrase such as “left arrow” and “up
arrow” rather than just saying solitary words such as “left” and “up.”

Taking the Toolbars to Task
The Standard and Formatting toolbars that share the second row of the
Excel window are by no means the only toolbars with which you’ll be work-
ing. The program comes with a whole carload of ready-made toolbars that
you can display or hide at any time while using the program. The easiest
way to display a hidden toolbar is to right-click somewhere on the menu bar
or on one of the already displayed toolbars (such as the Standard or
Formatting toolbar), and then click the toolbar’s name on the shortcut menu
that appears. You can also display a toolbar by choosing View➪Toolbars
and then choosing the toolbar’s name on the cascading menu that appears.

In Excel, as with the Office programs, the toolbars that you display in the
Excel window can be docked or free-floating. A docked toolbar is positioned
either above the formula bar or on the left, right, or below the active docu-
ment window (the Standard and Formatting toolbars are both docked side
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by side on the row below the menu bar). A floating toolbar is displayed in its
own window complete with title bar and Control menu button. Unlike a
docked toolbar that remains stationary at the perimeter of the worksheet
window, you can move and resize a floating toolbar as you want within the
active document window. 

To undock a docked toolbar, simply position the mouse pointer on the
dotted vertical bar in front of the very first button, and when the pointer
changes into a four-headed arrow, drag the toolbar toward the center of the
work area. As soon as the title bar appears, you can release the mouse
button.

To dock a floating toolbar, simply position the mouse pointer somewhere on
its title bar, and when the pointer changes to a four-headed arrow, drag the
toolbar to one of the four edges of the screen. As soon as the toolbar’s title
bar disappears, you can release the mouse button. When docking a floater
in an area that already contains other docked toolbars (such as the top area
that already contains the Standard and Formatting toolbar on the same
row), you can then reposition it on a new row by dragging it by the light
gray vertical bar in front of the first button.

After you’ve undocked a toolbar, you can then move the newly floating tool-
bar around the Excel work area by dragging the title bar. You can also
modify the shape of the toolbar window. To do this, position the pointer on
either the right edge or the bottom edge of the toolbar window. When the
pointer changes to a double-headed arrow, you then drag the mouse to
change the shape of the toolbar. 

If you’ve positioned the pointer on the right edge of the toolbar window,
drag to the left to make the window narrower and longer or to the right to
make the window wider and shorter. If you’ve positioned the pointer on the
bottom edge of the window, you can accomplish the same thing by dragging
the mouse down or up. Excel increases or decreases the number of rows of
tools in the toolbar window to accommodate the change in shape.

To return a floating toolbar window to its previously docked position,
simply double-click the toolbar. If you have modified the shape of a toolbar
before you return the toolbar to its docked position, the toolbar automati-
cally resumes this shape the next time you undock the toolbar. If you want
to remove a toolbar window from the work area without docking it, click the
Close button on the toolbar window. If you close a toolbar window without
docking it, the toolbar resumes its previous position and shape in the work
area the next time you display the toolbar.

In addition to moving and reshaping a toolbar, you can also customize the
tools that it contains and even create your own toolbars. For complete infor-
mation on how to customize Excel toolbars, refer to Book I, Chapter 3.
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